
BRX Do-more! Designer  
Getting Started 101010

ChapterChapterChapter

In This Chapter...
Overview ..................................................................................................................10–2

Before you begin  ....................................................................................................10–3

BRX Do-more! Designer System Requirements ......................................................10–4

Step 1: Install Do-more! Designer Software ...........................................................10–5

Step 2: Launch the Do-more! Designer Software ..................................................10–8

Step 3: Prepare the Hardware ..............................................................................10–11

Step 4: Apply Power to the PLC ...........................................................................10–14

Step 5: Establish PC to BRX MPU Communications .............................................10–15

Step 6: Verify Hardware Configuration ................................................................10–20

Step 7: Create a Ladder Logic Program ...............................................................10–23

Step 8: Save Project ...............................................................................................10–33

Step 9: Write Project to the BRX MPU .................................................................10–34

Step 10: Testing Project Using Data View ............................................................10–37

Do-more! Designer Software and Firmware Updates ..........................................10–41

Updating the Firmware .........................................................................................10–42

Live Update ............................................................................................................10–45

Update Operating System .....................................................................................10–46

Update Gate Array and Loader .............................................................................10–48

Dashboard .............................................................................................................10–50

Help File .................................................................................................................10–53



Chapter 10: BRX Do-more! Designer Getting Started

10–2 BRX User Manual, 1st Edition, Rev. A

1

10

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

E

Overview
The BRX Platform is a Micro PLC system that uses the Do-more! Designer Software version 
2.0 or newer (ADC part number DM-PGMSW).  The Do-more! Designer programming 
software package (downloadable for free) was developed as a powerful, flexible and easy to use 
controls design tool. 

The programming GUI features a user-friendly fill-
in-the-blank design for editing ladder logic, making 
complex operations such as PID and motion control 
easy to setup while minimizing programming time.  
A built-in simulator allows testing of your program 
design without requiring any additional external 
hardware.  This will help to reduce programming 
errors prior to critical live application startups. 

Easy to use troubleshooting tools allow you to 
actually see what is going on in your logic, from 
single stepping through the program one scan at 
a time to monitoring multiple elements during 
verification of correct program execution. 

For the DirectLOGIC users that want to use the 
BRX Do-more! MPU for projects originally written in DirectSOFT, Do-more! Designer 
software has a built-in DirectLOGIC migration tool that will greatly reduce the time to migrate 
a DirectSOFT program into Do-more! Designer. 

This chapter focuses on installing the Do-more! Designer software, establishing a connection 
to a BRX MPU, writing a simple ladder logic program and downloading it to the MPU.  This 
should help get you familiarized with the software and get started utilizing one of the most 
powerful PLC’s on the market. 
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Ethernet POM Module with Cable

Ethernet Cable Serial Cable
ZL-DB9F-CBL-2P

Before You Begin...
Wiring Tools and Hardware

RS-232 Serial POM (RJ12) Module with Cable

POM Slot Programming Options
• USB POM and cable assembly(below)
• Ethernet POM and cable (right)
• RS-232 serial POM (RJ12 or 3-pin)

(lower right)

Wire Strippers
DN-WS

Screwdriver
TW-SD-MSL-3 Electrical and 

Signal Wire AC Power Cord 
(Not available from 

Automationdirect.com)

RS-232 Serial POM (3-pin) Module with Cable

BX-PGM-CBL Programming Cable Assembly

The tools and hardware shown below may be required to connect your power 
supply to your BRX MPU 

Programming Connection Options

The BRX MPU allows several built-in programming interface options.  Choose from one of 
the following suggested communication methods for this short step-by-step introduction to the 
BRX platform.  You should have at least one of these programming options ready and available.  

• Ethernet port (built-in), just connect a cable
• Serial port: Using the 3-pin serial connection on the MPU
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BRX Do-more! Designer System Requirements
Do-more! Designer Windows-based programming software (CD-ROM or web download) 
works with a variety of Windows® operating systems listed below.   

Do-more! Designer software can connect to the BRX system using one of the following 
specifications.  More detailed specifications and options are listed later in this chapter.

BRX Do-more is compatible with any of these PC operating systems: 

•	 Windows® 10

•	 Windows® 8.1 - 64 bit

•	 Windows® 8.1 - 32 bit

•	 Windows® 8 - 64 bit

•	 Windows® 8 - 32 bit

•	 Windows® 7 - 64 bit

•	 Windows® 7 - 32 bit

•	 Windows® Vista - 64 bit

•	 Windows® Vista - 32 bit

Hardware Requirements: 
•	 HD Space: 140Mb
•	 Video: 1024x768 256 

color (1280x720 true color 
recommended)

•	 1GHz , single core CPU (2GHz, multi-core recommended)
•	 1GB RAM (3GB recommended)

•	 Other: Windows® 8 RT Edition is not supported.

NOTE: Ethernet POMs, USB and Serial Cables are sold separately.  USB or Ethernet cable is also required 
for communications between PC and CPU.
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Step 1:  Install Do-more! Designer Software
Download the Do-more! Designer programming software (DM-PGMSW) from our website 
at http://support.automationdirect.com/products/domore.html, and launch the install procedure.  

If you already have Do-more! Designer installed, 
you can just update to version 2.0 or newer to get 
BRX MPU support.  

The first window that opens displays the Welcome 
screen seen here.  If there are previous versions 
of the software already installed, this screen will 

show the version number of the software 
being replaced as well as the one being 
installed.  Click Next to continue.

An alert window will appear requesting 
that all anti-virus software be disabled 
and also reminding the user that 
administrative restrictions may exist.  

The License Agreement window will 
be displayed next.  Read over the 
agreement, select I accept the terms 
of the license agreement and click 
the Next button to continue.

The license agreement may be 
printed if desired.  The Print 
function will print a pdf of the 
License Agreement document to 
your default printer. 
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At this point the software will ask 
a little about you.  Please fill in the 
user information requested on the 
Customer Information screen and 
click Next to continue.  

At this stage, the software will ask 
which type of install you would 
like to perform.  The Setup Type 
window seen below gives two 
options for installation type: 
Complete and Custom.  

Custom installation allows you 
to choose which program features 
to install, whereas Complete 
installation installs all of the 
program features available.  The 
Complete installation is selected 
by default and is recommended for 
first-time users and for purposes 
of this primer.  Click Next to 
continue.

The next window to appear is 
the Ready to Install the Program 
window.  This window is an alert 
window, cautioning you that the 
program is about to be installed.  If 
there are any changes that need to 
be made to the install settings do 
them now before continuing.  

To review or change any of the 
previous installation selections, 
click Back to return to the 
appropriate window and make 
the change.  If no changes are 
necessary click Install to begin the 
installation.  
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The pop-up shown here will allow you 
to choose to install a Do-more! Designer 
software desktop shortcut  on your PC.  
Click Yes or No and continue with the 
installation.

The software will now install the 
needed folders and files while the 
Setup Status window displays the 
installation progress status.

Once the installation has been 
successfully completed, the 
InstallShield Wizard Complete 
window below will open.

Your software is now installed 
and ready to use.  The installation 
wizard can now be closed by  
clicking Finish. 

NOTE: By default the Read Me File and Launch Do-more! Designer now boxes are checked.  Un-check 
either box should you choose not to view the Read Me file and not launch the software at this time. 
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Step 2:  Launch the Do-more! Designer Software 

NOTE:  For this step, ensure the BRX MPU is not powered up.  Connection to your PC is in Step 3. 

NOTE:   There are many keyboard shortcuts available in the Do-more! Designer software.  For a list of 
available short cuts (hot keys), view Help topic DMD0361.

After installing the Do-more! Designer software, launch 
the software by double clicking the desktop Do-more! 
Designer icon. 

You can also launch the software from your PC Start 
menu or All Programs menu.  If the software link is 
not embedded in the Start menu, use the path: Start > 
All Programs > Do-more > Designer x.x > Do-more! 
Designer x.x to launch the software.

When Do-more! Designer runs for the fi rst time it 
goes to the Start Page (area with 'brick' wallpaper) and 
the Tip of the Day pop-up comes up by default.  This 
feature can be disabled by un-checking the Show tips at 
startup box in the lower left corner.  Select Close on the 
Tip of the Day pop-up when you are fi nished viewing the tips.   pop-up when you are fi nished viewing the tips.  
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When the Close button on the Tip of the Day pop-up is pressed, the Select Project window 
comes up.  Here you will select which project to work with - New Offl ine Project, New Online 
Project, or Browse (for a project not listed).  If you have worked on current projects, they will 
appear below in the Recent Project list.  As this is your initial install your window will be empty.

Press the Close button.  The Launchpad area (on left side of window) is displayed with the 
Startup Page selected.



Chapter 10: BRX Do-more! Designer Getting Started

10–10 BRX User Manual, 1st Edition, Rev. A

1

10

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

E

From the Start Page, you can select from any of 5 short videos that demonstrate how to use the 
software and explain how the Do-more! technology works. 

• Video 1: "Welcome”, welcomes you to the Do-more! Designer Software.  This video 
familiarizes you with the BRX environment showing you how to connect to a BRX MPU, 
open a project, etc.

• Video 2: “Quick Start”, walks you through writing and documenting a simple program 
and downloading it to the BRX MPU.

• Video 3: “Troubleshooting”, introduces you to and shows you how to use the 
troubleshooting and debugging tools built in to the Do-more! Designer software.

• Video 4: “Architecture”, explains how the Do-more ! Technology works.  Understanding 
the Do-more Technology allows you to take advantage of the built-in features allowing 
you to create projects easier and decreasing the amount of programming time needed.

• Video 5: “Helpful Hints”, covers some of the most common BRX MPU programming 
challenges and explains how easily Do-more! Designer can help with these challenges.  

The Video Search & Download Utility opens a search window and download screen.  

Video 1: "Welcome”, welcomes you to the Do-more! Designer Software.  This video 
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Step 3:  Prepare the Hardware
The “Installation and Wiring” chapter for the BRX MPU contains detailed information for 
your specific model.

The following summary explains the basic steps needed to get the BRX MPU ready to establish 
a link so you can program and run a project.

1.	 �Installing the BRX MPU on DIN rail: 
A.	 Hook rear upper tabs over flange of DIN rail.  
B.	 Rotate the unit down toward the DIN rail, pressing firmly 

until the BRX MPU snaps securely to the DIN rail. 

2.	 There are three ways to connect to the BRX MPU for programming: 
A.	 Using the USB POM with a USB programming cable.
B.	 Using Ethernet cable with built-in Ethernet port.
C.	 Using RJ12 Serial POM module and RJ12 programming cable or via 

the built-in 3-pin serial port connector with user supplied cabling. 

Examples of each connection type are shown on the following pages.  

NOTE:  All communication connections between the BRX MPU and PC should be completed prior to 
launching Do-more! Designer software.  

     Hook base 
     onto DIN 
rail at top of 
mounting slot.

Rotate base 
into position. Gently push up 

retaining clip to
lock component
onto DIN rail.

1

2 3
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A. Connect BRX USB to Computer Using Programming Cable
For USB connectivity the BX-PGM-CBL assembly is required.  This assembly includes one 
USB POM module (BX-P-USB-B) and one 6ft USB-A to USB-B cable (USB-CBL-AB6).

B. Connect BRX Ethernet to Computer Ethernet
There are two options for connecting the BRX via Ethernet to a PC.  One option is to use 
the built-in Ethernet port and connect to the PC via a Cat5 Ethernet cable.  An alternate 
connection is available by using the optional Ethernet POM (BX-P-ECOMLT) module that 
plugs into the POM slot on the MPU.  Both Ethernet options support 10/100Base-T via the 
RJ45 port.  The Ethernet port supports Auto-Crossover, which allows the use of a Cat5 patch 
or crossover cable.

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-

TX/D+

GND

Built-in Ethernet to PC

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-

TX/D+

GND

● �Using the Programming Cable 
Assembly (BX-PGM-CBL), install 
the USB POM unit into the MPU 
Plug-in POM slot as shown.

● �Using the USB cable, connect the 
MPU to your computer.
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C. �Connect BRX Built-in Serial Port BRX POM serial port to Computer Serial 
or USB Port

It is possible to connect to the BRX using the CPUs built-in serial port or by installing the BRX 
POM serial port, BX-P-SER2-RJ12. 

BRX Built-in Serial Port. 
There are two options to consider for connecting the BRX built-in serial port to a PC.  The first 
option uses a ZL-DB9F-CBL-2P to a PC USB port using a USB to Serial adapter (USB-RS232, 
as shown below).  If the PC has a 9-pin serial port connection, you don’t need to use the USB 
to Serial adapter.  The second option (not shown) is to use a user built cable to connect the 
built-in 3-pin serial port to the PC serial port or USB to Serial adapter.

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-

TX/D+

GND

POM Ethernet to PC

BRX POM Ethernet (BX-P-ECOMLT)

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-

TX/D+

GND

ZL-DB9F-CBL-2P

USB-RS232
Use if PC does 
not have a built-in
RS-232 DB-9 port.

EA-MG-PGM-CBL

Serial RS-232 to PC

BRX 3-Pin Serial Port
ZL-DB9F-CBL-2P

To 3-pin 
TerminalPin # Term Color

2 RXD Brown ....... TXD

3 TXD Red ....... RXD

5 GND Yellow ....... GND

7 RTS Blue
Jumper

8 CTS Violet
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Step 4:  Apply Power to the PLC

WARNING:  Minimize the risk of electrical shock, 
personal injury, or equipment damage.  Always 
disconnect the system power before installing or 
removing any system component.

Once all of the power wiring has been completed 
and verified, connect the appropriate voltage source 
to the power supply and power up the system.  The 
BRX MPU will perform a self-evaluation once 
power is applied.  

The following summary explains the basic steps needed to get the BRX MPU ready to establish 
a link for programming and running a project.

NOTE:  Please see Chapter 1 for the power wiring diagram corresponding to your specific BRX MPU.

-
+

G
IN-
IN+

DC
Power

DC Power In

12–24 VDC

BRX POM Serial Port 
The BRX Serial POM (BX-P-SER2-RJ12) can connect to a PC by using the D2-DSCBL 
programming cable.  The 9-pin connection of the D2-DSCBL cable can be connected to a serial 
port on a PC or to a USB to Serial adapter (USB-RS232, as shown below).

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-

TX/D+

GND

Filler
Module

D2-DSCBL

USB-RS232
Use if PC does 
not have a built-in
RS-232 DB-9 port.

POM Serial RJ12 Port to PC
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Step 5:  Establish PC to BRX MPU Communications
The BRX MPU should now be powered up and the programming cable connected. 

NOTE:  The following example assumes that you are using the USB POM.   

The fi rst time the BRX USB POM is connected to your PC, you should see a message on your 
PC indicating that the driver for the USB device was successfully loaded:

When the USB connection is made, Do-more! Designer 
detects the USB POM and (a) creates a new link, shown in 
the (b) Links window of Launchpad area.

From the Links window (b) you can open, edit, or create 
a new link manually.  You can also delete a link or get link 
information.  For this exercise, we will work with the link 
that was generated automatically when the USB POM was 
inserted. 
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1. We are now ready to go online with the MPU.  In the (a) Links 
section of the (b) Launchpad, select the (c) USB link; in this 
example it is called BX-DM1E-X 00:3A.  Click on (d) Open 
button.

2. Once connected to the MPU, you may encounter the 
initialization screen shown below.  This will appear on first 
initialization of a new MPU.  Select Set PLC Clock to set the 
clock in the new MPU to be synchronized with your PC clock.  

3. The Set PLC Clock option allows you to set the internal, real-time 
clock of the BRX MPU.  The Set PLC Clock window has options 
for (b) Timezone and (a) Daylight Saving Time adjustments.  
Select (c) Set to PC’s current time settings… then select 
(d) Set PLC Clock and Exit.  
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4. The option for Setup System Configuration appears next (below).  This allows 
you to configure parameters of the BRX MPU, such as onboard communication 
port configuration, I/O configuration (i.e. high-speed), and mapping.  Select 
Setup System Configuration. 

5. The System Configuration window appears next with the (a) CPU Configuration selected 
by default.  This window and those indexed in the (b) Configuration Entries tree on left, 
expose many of the system operating parameters for your MPU.  For purposes of this 
introduction we will accept the default settings.  Click (c) OK. 
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The Setup System Confi guration box reappears.  Select Finish button to move to next step. 

6. The Project Browser (a, b), including the Dashboard (d), will open with the online 
toolbar (c) active.  Notice the status bar indications (e, bottom of window) show 
the MPU type, memory usage, communication status, errors, and mode, etc.  
Hovering your mouse over the status bar (e) will highlight the items that are selectable.  If you 
select one of the items, a new window will open with real-time data and available options. 

The (a, b), including the Dashboard (d), will open with the online 
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For example, the System Information window seen below, opens after selecting the 
memory usage values (f) in the status bar.  This information and much more can be 
accessed by way of the Dashboard, a new addition to the Do-more! Designer software.
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Step 6:  Verify Hardware Confi guration
Next we will verify the hardware confi guration.  The BRX series has an auto discover feature 
that will automatically detect installed I/O modules.  You can access the System Confi guration 
in three ways:

1. By selecting (a) PLC > System Configuration
2. By double clicking on the (b) CPU link under the Configuration tab in the Project 

Browser
3. By clicking the (c) X/Y Configure icon on the project toolbar.
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On the left side of the System Confi guration window is an index of topics titled (a) Confi guration 
Entries.  The (b) BRX Onboard I/O allows you to view the modules the software has detected.  
For this example, we are working with a BX-DM1E-10ER3 MPU and no expansion I/O.  This 
unit has a built-in (c) Ethernet port and a (d) USB POM plugged in which show up in the 
overview graphic.  

The (a) BRX Onboard I/O graphic area is interactive, like the system Dashboard, and as you 
hover and move across the image (b) "orange" boxes will appear and display information about 
the highlighted section.  

Also if the highlighted 
section can be 
configured you 
can click in the 
highlighted area and 
a confi guration screen 
will pop up.  For 
example hovering 
over (b) the built-in 
analog I/O hot spot,  
a pop up will display 
information on how 
the analog I/O is 
confi gured.
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After the hardware confi guration is verifi ed, select (a) the I/O Mappings option in the 
Confi guration Entries index.  This option will display (b) the assigned addresses for the 
available I/O, as seen below.

These (c) X (discrete input), Y (discrete output), WX (analog input) and WY (analog output) 
addresses are automatically assigned by Do-more! Designer.  You have the option to manually 
confi gure these addresses by selecting (d) Manual in the Mapping Mode section at the bottom 
of the window or by right clicking (g) BRX Onboard I/O.  Change default starting address in 
(e) Edit Base's Default Map Addresses dialog box.  Click (f) OK when completed to close Edit 
Base's Default Map Addresses dialog box. 

The (a) Manual Mode Instructions section, also found at the bottom of the window, details the 
various color indications associated with this mode.

Once the hardware and mapping is confi gured and verifi ed, click (b) OK to return to the main 
screen, displaying the Dashboard and the Project Browser.

These (c) X (discrete input), Y (discrete output), WX (analog input) and WY (analog output) 
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Step 7:  Create a Ladder Logic Program
In order to create a ladder logic program, you will need to be in Edit Mode.  All programs start 
with a default $Main code block.  We will be adding our ladder logic to this code block.  

We can get to the $Main code block four different ways:
1. By selecting the (a) $Main navigation tab.
2. By double clicking on the (b) $Main option under the Control Logic section of the 

Project Browser.
3. By selecting (c) View/Edit the Program under the Program section of the Dashboard.
4. By using the drop-down menu (d) View > Ladder View, as seen below.
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When in (a, b) Edit Mode,  the ladder palette toolbar (c) and all of the ladder (d) Instruction 
Toolbox options will become active.  The cursor will be positioned on (e) Rung #1 and 
highlighted. 

Rung #1
Place the cursor box in the (a) NOP position on Rung #1.  If the (b) Instruction Toolbox is not 
open, click on the (c) Instruction Toolbox button from the ladder palette toolbar.  



Chapter 10: BRX Do-more! Designer Getting Started

10–25BRX User Manual, 1st Edition, Rev. A

1

10

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

E

Rung #1, Continued
Now, you are ready to begin entering the example ladder logic.  

Click on the section heading (a) Timers/Counters/Drums and (b) double click or drag/drop 
the TMR instruction.

Or you can type “T” while the cursor is on the (c) NOP position and select TMR from the 
drop down menu, then press Enter. 
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Rung #1, Continued
Once the TMR is selected, a Timer dialog box appears.

1. Set the (a) Timer Struct to T0 

2. Enter 03 into the (b) Preset Constant Value for the seconds (s) preset.

3. Click on the (c) green checkmark in the upper left corner to accept.

After clicking the checkmark, Rung #1 should show the (d) T0 timer (TMR) instruction with a 
Preset of 3.000 seconds.  A user variable can be assigned to the Preset value if needed, to allow 
the timer preset to be set from an external source.

Since a Timer is a structure, it has predefi ned elements associated with it, such as “Tx.Acc” 
(accumulated time), “Tx.Done” (the completion bit) and "Tx.Timing" (the timer is enabled 
and timing). 

Therefore, if T0. (the "period" must be used to open drop-down list) is entered into any 
contact name, the Auto-Complete feature of Do-more! Designer will display all applicable bit 
(Boolean) selections available for that structure.  Selecting (e) the T0.Done element, as seen 
above, will assign this element to the contact and the contact name will be T0.Done. 

This feature works for all structures including: timers, counters, PID loops and strings.  Many 
system data types such as, $Main and $FirstScan, as well as user-created devices like ECOM, 
CTRIO, or SERIO modules also use the Auto-Complete feature.  See the Do-more! Designer 
Help fi le topic DMD0327 for more information on structure members.
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Rung #1, Continued
Place the cursor in the (a) leftmost column of rung #1.  Type the nickname T0_Start at the (a) 
cursor position.  The (c) Normally Open contact instruction (b) will be used by default as the 
nickname is entered.  Press Enter.

Another option is to select the (d) Normally Open Contact 
instruction from the Ladder Palette Bar (F2 Hot Key) 
or (b) double-clicking or drag/drop from the Instruction 
Toolbox, enter T0_Start for the name, and click the (c) green 
checkmark in the upper left corner. 

Either method will open the Create Nickname 
dialog seen here (Right).  Select (a) the option …
assign to specifi ed element, (b) type the desired 
memory bit for this contact (C1), and select (c) OK 
to accept.

Rung #1 should appear as shown below.

Another option is to select the 
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Rung #1, Continued
With the cursor in the position to the (a) right of contact T0_Start, begin drawing a branch 
circuit.  Under the Edit drop-down menu, select Wire, then select (b) Down.  Notice the 
shortcuts that are available for wire drawing.  The wire could also be drawn using the shortcut: 
(c) Ctrl+Down Arrow.  The (d) wire should now appear in your ladder.  

NOTE: There are also Delete Wire options in the Edit drop down menu that are used to erase any wires not 
needed.
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Rung #1, Continued
Place the (a) cursor in the space to the left of the new line and select another normally open 
contact.

Type in the nickname (b) T0_Manual and (c) assign bit C2.  Select (d) OK to accept. 

Rung #1 should look like this:
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Rung #2

Place a normally open contact in the fi rst position of (a) Rung #2.  This contact will be tied to 
the Done bit of timer T0.  Therefore, the name for this (b) contact should be entered as “T0.
Done”.  There should be no Create Nickname dialog box as seen with the earlier normally 
open contacts.

Lastly, you will need to add an Out coil to the end of Rung #2.   Place the (a) cursor at the 
end of the rung highlighting NOP and either select Out from the Ladder Palette Bar, or type 
“OUT” and select the OUT instruction from the drop down menu.  Another option is to (b) 
select the OUT instruction from the Instruction Toolbox under the Coil/Bit Output section. 

Next, choose which bit will be tied to this coil.  Tie this (c) coil to the physical output Y1 by 
typing “Y1” and clicking the (d) checkmark.  

Lastly, you will need to add an Out coil to the end of Rung #2.   Place the Out coil to the end of Rung #2.   Place the Out
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The ladder program should now look like this:

When either the (a) T0_Start or (b) T0_Manual contact is energized, the timer will begin 
timing.  When it times out, contact (c) T0_Done will energize and the (d) output coil Y1 will 
turn on.  Note that an END instruction is not required.

The (a) yellow bar in the left margin signifi es logic that has not been accepted.  So once you 
have verifi ed your logic, click the (b) Accept button in the Project Toolbar or the (c) Ladder 
Palette Bar to accept the changes.

When either the (a) T0_Start (b) T0_Manual contact is energized, the timer will begin 
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After selecting “Accept”, the yellow bar should be replaced by green and blue bars (left margin).  
The green bar means the project has been accepted but not saved.  The blue bar (only appears 
when online) means the project has not been downloaded to the MPU. 
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Step 8:  Save Project
Save the project by selecting (a) Save Project from the File drop down menu (Ctrl+S), or save 
the fi le under a different name or in a different location by selecting the (b) Save Project As…
option.  You can also save the project by selecting the (d) SAVE icon on the Project Toolbar. 

Once you save the project, the green bar on the left side of the ladder will disappear and the 
blue bar (c) will remain, meaning you have successfully saved the project to disk, but not yet 
downloaded to the MPU.
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Step 9:  Write Project to the BRX MPU
Now that you have created the example ladder logic program, you can write the program to the 
MPU.  As a quick review, (a) check the status bar at the bottom of $Main window to verify you 
are Online with the MPU.  Also notice the (b) blue bar to the left of the ladder logic program 
signifying that your project has been Accepted and Saved and you are online with the MPU.  

There are several ways to write the project to the MPU.  You can chose 
(c) Write PLC button from the Project Toolbar or select (d) Write to 
PLC from the File drop down menu (Shift+F9).  
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When the Write PLC button is selected and the MPU is in program mode, the Download 
Project to PLC pop-up window seen here appears.

When the BRX MPU is in (a) Program mode and you click on the (b) OK button, the project 
is written to the MPU.  When the download is complete, the MPU remains in program mode.  
In this window, you can select (c) to switch the MPU to RUN mode after the download is 
complete. 

You can also select (d) not to display the Download Project to PLC window if the MPU is in 
program mode, keeping in mind that selecting this option will not download any Memory 
Image.  Please view the Do-more! Designer HELP topics for details on the features available in 
the Download Project to PLC window.

NOTE:  It is good practice to verify that the process you are controlling can be interrupted before 
downloading a project to the MPU.
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If you do not select the option to Switch to 
RUN mode after the download completes, you 
can switch to RUN mode manually several 
ways: 

• Click on the MODE icon on the 
Project Toolbar

• Click on (a) Program in the Status bar.  This will bring up the Select PLC Mode pop-up 
where you can change the PLC mode by selecting the (b) Run radio button. 

• Select PLC Modes 
from the PLC drop 
down menu or 
use the shortcut, 
Ctrl+Shift+R.
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Step 10:  Testing Project Using Data View
With the project successfully downloaded to the MPU and the unit in RUN mode, you can 
now test the function of the ladder program using the Data View tool.

Start by opening a new Data window.  To do 
this, click on the (a) Data icon on the Project 
Toolbar, or (b) select menu item Debug > 
Data View > New (Ctrl+Shift+F3).

The Data View window shown below (c) will open.  This window will open in the project 
browser section of the programming window but it can be (d) relocated anywhere on the screen 
by clicking the title bar and dragging it to a new location. 
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Now enter the elements that you wish to 
monitor.  On line one type “C1” under 
the Element column and press Enter.  You 
will see the C1 change to the (a) nickname 
associated with it, T0_Start.  On line two 
(b) type the element “C2” (T0_Manual) 
and on line three (c) type “Y1”.  Notice the 
three icons (d) at the top right in the data 
window are grayed out.  This will change 
in the next step. 

With the ladder elements entered into the Data 
View window, you now need to activate their 
status.  To do so, (a) click the All Status icon on 
the Project Toolbar, or (b) select Debug > All 
Status On.  The All Status On option will not only 
activate (c) the Status of the Data View window 
but also the status of the (d) ladder program as seen 
below.  The timer structure now shows the status of 
its structure elements, including the accumulated value. 
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The next step is to enable edits within 
the Data View window.  To do this, 
click the (a) yellow box with the E 
found in the top left corner of the Data 
View window.  The (b) Edits column is 
now added to the Data View window. 

The Edits column allows you to make 
changes to the current values of the 
elements listed. T0_Start’s current 
value is OFF.  Double-click the (c) ON
button under the Edits column.  The 
(d) Write Current Edit and the Writes 
All Edits buttons will appear at the top 
of the window.  The buttons will write 
individual or all edits, respectively, made 
in the Data View window to the MPU.

Click the Write Current Edit to PLC button and confi rm it.  This will write the new value 
to T0_Start.  Once T0_Start changes to an ON state, the timer (T0) will begin to time and 
quickly reach the preset.  As soon as the preset has been met the done bit, T0.Done, will turn 
ON causing output Y1 to also turn ON, as seen on the following page.  Now write an OFF to 
T0_Start and watch as the timer and Y1 reset.
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With All Status ON, you can view instruction 
information in the ladder view (below).  For example, on 
the TMR instruction you can see the actual accumulated 
time while the timer is on, and when the timer is done, 
to mention a few.

Congratulations, you have now programmed, downloaded, and tested a ladder logic program 
for the BRX Do-more MPU.  Feel free to experiment with a program of your own and please 
remember that the software Help fi le is an essential tool to use when programming your 
controller.
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Do-more Designer Software and Firmware Updates
There will be times when an update is available for the BRX fi rmware or the Do-more Designer 
programming software.  The Do-more! Designer software makes it very easy to download the 
updated fi les.

By default, checking for updates is done automatically each time Do-more! Designer is started.  
Do-more! Designer will check for updates to the programming software, the Help fi le content, 
Start Page content, new fi rmware for BRX Do-more and Do-more! controllers and new 
fi rmware for CTRIO(2) modules.  An Internet connection is required to perform the check 
and to download the updates.

When updates are available, the user is notifi ed through this dialog:

The automatic check can be disabled by opening the View -> Options menu, select the Global 
tab and uncheck the “Automatically Check for Updates on Startup” selection.
The automatic check can be disabled by opening the View -> Options menu, select the Global 
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Do-more Designer Software and Firmware Updates, continued

To manually check for software or fi rmware updates, go to 
HELP -> Check for Updates.

Do-more Designer Help Topic DMD0310 provides 
detailed information on downloading the programming 
software updates, fi rmware updates, Do-more Designer 
Help System updates, and HTML/Documentation updates.

Updating the Firmware

NOTE:  Downloading the fi rmware fi les does not automatically 
update the fi rmware of the connected BRX PLC.  You must use the 
available tools to update the Operating System and the Gate Array 
and Loader.  The available tools will indicate when the fi rmware is 
not up to date in the controller.

There are three ways to access the dialogs needed to update 
the Operating System and the Booter/Loader.  

The fi rst method is by using the (a) Info icon on the online toolbar.  A second method is by 
selecting the (b) OS or (c) Booter links under the CPU section of the Dashboard.



Chapter 10: BRX Do-more! Designer Getting Started

10–43BRX User Manual, 1st Edition, Rev. A

1

10

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

E

Do-more Designer Software and Firmware Updates, continued

The third method is through the menu, PLC -> Update 
Firmware.

When you select the Info icon on the online toolbar, the 
System Information utility (below) comes up.  To update 
the controller fi rmware, use the section under CPU Version 
Information.  

The CPU section displays the following information:
• Do-more:  The current version of the instruction set in 

the controller.
• OS:  The current version of the operation system in the 

controller.
• Booter:  The current version of boot loader in the 

controller.
• FPGA:  The current version of the Gate Array code in 

the controller.
• Hardware:  The current revision of the controller hardware.

NOTE:  An Asterisk (*) next to any of the numbers means that there is an update available for that 
particular portion of the fi rmware.
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Do-more Designer Software and Firmware Updates, continued

• Click the Update button (a) adjacent to the Do-more 
& OS display to open the Update Operating System 
dialog.  

• Click the Update button (b) adjacent to the Booter & FPGA display to open the 
Update Gate Array and Loader dialog.

NOTE:  If both the Booter and OS need updating, it is recommended to do both updates.  

NOTE:  DIP switch #3 (on MPU) is used to Enable/Disable the ability to update the fi rmware in the 
controller.  This DIP switch must be OFF to allow Do-more Designer to update the operating system or 
the gate array.  Please review Do-more Designer Help topic DMD0266 for information on the on-board 
dipswitches.

The dialog shown below is displayed when you use the OS or Booter link under the CPU 
section of the Dashboard or you use the menu PLC -> Update Firmware.

The Update Firmware dialog has the necessary tools to download new fi rmware fi les from 
the Web and update the 
connected Do-more CPU.

The Operating System and 
Booter sections show the 
version currently running 
in the attached Do-more 
CPU and the latest versions 
of the fi rmware and boot 
loader fi les that have been 
downloaded to this PC.

Click the Update button (b) adjacent to the Booter & FPGA display to open the 

the Web and update the 
connected Do-more CPU.

The 
Booter
version currently running 
in the attached Do-more 
CPU and the latest versions 
of the fi rmware and boot 
loader fi les that have been 
downloaded to this PC.
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Do-more Designer Software and Firmware Updates, continued

Click (a) Check for New Firmware (previous graphic).  The Live Update tool comes up, 
which allows you to see if there is a newer fi rmware available, and if so to download the updated 
fi les.  The Live Update tool is discussed later in this chapter.

Clicking (b) Update PLC Operating System (previous graphic) opens the Update Operating 
System dialog that shows detailed information about the attached CPU's operating system and 
Do-more Technology versions and selects the latest Operating System fi rmware fi le based on 
the connected Do-more CPU.  The Update Operating System dialog is discussed later in this 
chapter.

Clicking (c) Update PLC Booter (previous graphic) opens the Update Gate Array and Loader 
dialog that shows detailed information about the attached CPU's Gate Array and Boot Loader 
versions and selects the latest Boot Loader fi rmware fi le based on the connected Do-more CPU.  
The Update Gate Array and Loader dialog is discussed later in this chapter.

NOTE:  If both the Booter and OS need updating, it is recommended to do both updates. 

Live Update

NOTE:  DIP switch #3 (on MPU) is used to Enable/Disable the ability 
to update the fi rmware in the controller.  This DIP switch must be 
OFF to allow Do-more Designer to update the operating system or the 
gate array.  Please review Do-more Designer Help topic DMD0266 for 
information on the on-board dipswitches.

Click the Use Live Update to get Firmware button to open 
the Live Update dialog.  Live Update will utilize the Internet 
connection to check for new fi rmware fi les for the Do-more 
controllers and the CTRIO modules, then download any new 
fi les to the appropriate Bin\Images\< Device > folders.
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Do-more Designer Software and Firmware Updates, continued

Click the Go! button to check for 
updated fi rmware fi les. 

Click the OK button to close the Live 
Update dialog.

NOTE:  Live Update requires a functional 
Internet connection to work.  Make sure 
the Internet connection is active before 
running Live Update.

Update Operating System
When the dialog opens it will read the OS Version and Do-more versions from the currently 
connected controller, and from the latest operating system fi rmware fi le.
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Do-more Designer Software and Firmware Updates, continued

Current Operating System Information
OS Version - the current version of the operation system in the controller 

Do-more Version - the current version of the instruction set in the controller

New Operating System Information 

OS File - the most up-to-date operating system firmware file in the default firmware folder 

Select... - opens a File Open dialog to select an operating system firmware file.  Operating System 
firmware files typically have the following form: "H2DM1x_<major>_<minor>_<build>.os" 

Description - the current version information from the selected file

OS Version - the current version of the operation system in the selected file

Do-more Version - the current version of the instruction set in the selected file

Click the Update! button to begin the update progress.  The last phase of updating the 
operating system is a reboot of the Do-more controller.  While the controller is rebooting, 
the normal communication updates will fail, and the Link indicator on the Status bar will 
turn red.  Once the controller has successfully rebooted, normal communication updates will 
automatically resume, and the Link indicator will return to normal.

Click the Cancel button to exit without updating the operating system.
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Update Gate Array and Loader

WARNING!  There is no fail-safe for the Gate Array and Loader update, which means, if the update 
process begins and then fails, ** DO NOT TURN OFF THE POWER**, keep trying the update process 
until it is successful. If you turn off the power without a successful update the controller must be sent 
back to the factory for repair (use the 'H/W Repair (RMA)' link at www.hosteng.com to request an RMA 
number for a Do-more CPU that fails to update the Gate Array and Loader).

When the dialog opens it will read the Gate Array Version and Boot Loader version from the 
currently connected controller and from the latest Gate Array fi rmware fi le.



Chapter 10: BRX Do-more! Designer Getting Started

10–49BRX User Manual, 1st Edition, Rev. A

1

10

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

E

Current Gate Array and Loader Information 
Booter Version - the current version of Boot Loader in the controller

Gate Array Version - the current version of the Gate Array code in the controller

New Gate Array and Loader Information

GA File - the most up-to-date Gate Array fi rmware fi le in the default fi rmware folder

Select... - opens a File Open dialog to select a Gate Array fi rmware fi le.  Gate Array fi les 
fi rmware fi le typically have the following form: "H2DM1x_<major>_<minor>_<build>.ga"

Description - the current version information from the selected fi le

Booter Version - the current version of Boot Loader in the selected fi le

Gate Array Version - the current version of the Gate Array code in the selected fi le

Click the Update! button to begin the update progress.  When the Gate Array and Loader 
update is complete, you will see the following window with instructions to power cycle the 
PLC.

Click the Cancel (previous graphic) button to exit without updating the Gate Array and 
Loader.
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DASHBOARD 
The Do-more Designer Dashboard is a graphical representation of the PLC system.  It is used 
to assist in the confi guration of the various components of the system as well as for monitoring 
and troubleshooting after it is up and running.  The following pages will be a quick overview 
on how to use the Dashboard.  Please reference Do-more Designer Help topic DMD0415 for 
more detailed information.

The dashboard is divided horizontally into three sections, top, center and bottom sections.  
The top and bottom sections consist of distinct panes each of which contain related items with 
current status of each.  These entries (a) are also mouse-over links; as you move your mouse 
over an entry it will highlight in red and a pop-up text box will appear with more detailed 
information.  Left click a link to open a dialog that addresses the confi guration of that entry, or 
opens a monitor tool for that entry.

Entries (b) that have an orange ( ! ) next to them indicate items that need your attention.  
For example, an orange (!) adjacent to the "OS: x.y.z" item in the CPU section indicates the 
fi rmware in the CPU is older than the fi rmware you have downloaded to this PC.  Click the 
link to open the fi rmware update tool.

Some entries will have their text displayed with a yellow background to indicate the item is 
generating a warning message that may need your attention.  For example, if you have Forces 
enabled and one or more items are currently being Forced to a value, the Memory section 
will display the "x forces active" text with a yellow background.  Click this link to open the 
Confi gure Forces dialog to see what elements are being forced.

Some entries will have their text displayed with a red background to indicate the item is 
generating a warning message that may need your attention.  For example, if an I/O module 
is reporting an error, the I/O section will display the "I/O System Status" text with a red 
background.  Click this link to open the I/O System View to see an overview of the entire I/O 
system and locate the module that is reporting an error.
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The center section contains a series of tabbed (a) graphical representations of the PLC system 
components.  The leftmost (top) selection is the local CPU.  There is an additional tab created 
for each Ethernet Remote I/O Slave.  Any time the mouse cursor is in the center section (b) 
orange outlines (known as hotspots) will appear on the sections of the PLC system to indicate 
there is status information available for that area or confi guration that can be performed.

Hovering the mouse cursor over any of the hot spots will display a popup that shows the current 
status of the item in that hotspot.  For example, hovering over the DI hotspot (c) will display 
information on the response times confi gured for the discrete inputs and, if the unit supports 
high speed inputs, it will display how the high speed Counter/Timer functions are confi gured.
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Left-clicking on the hot spot will display a popup menu that contains links specifi c to the 
confi guration tools and information displays for that item.  For example, left clicking on the 
AIO (analog I/O) hotspot, displays links to view onboard analog I/O values in Data View and 
a link to confi gure the analog I/O, as shown below.

Right-clicking on the MPU or an expansion module will display a list of operations that can be 
performed on that module.  For example, right-clicking on the MPU (below) gives the option 
to Change CPU Type, Connect to PLC, or Disconnect from PLC.  The options will vary 
depending on the MPU family and module type.

Right-clicking on the MPU or an expansion module will display a list of operations that can be 
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Help File
Accessing the Help File  

The software Help fi le is available as a quick reference or detailed guide to the many features 
and capabilities of the Do-more! Designer software.  This provides comprehensive support for 
you as a user of not only the BRX Platform but also the whole Do-more product family. 

There are three ways to access the Help File:
1. Select the Help File icon from the Project Toolbar.
2. Choose Help from the Help menu drop down.
3. Use the shortcut F1 or press the(?) button or the Help button on the dialog that you 

need help with.
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Notes: 


